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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other component
manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the
product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it must remain
accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by qualified
service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Replace Batteries Properly. Replace batteries only with the specified type and rating.
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General Safety Summary

Recharge Batteries Properly. Recharge batteries for the recommended charge cycle only.

Use Proper AC Adapter. Use only the AC adapter specified for this product.

Do Not Operate in an Explosive Atmosphere.

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.
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General Safety Summary

The following symbol(s) may appear on the product:
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Environmental Considerations

Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the product’s end of life. In
order to avoid release of such substances into the environment and to reduce the use of natural resources, we encourage you to
recycle this product in an appropriate system that will ensure that most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the European Union’s requirements according to Directive
2002/96/EC on waste electrical and electronic equipment (WEEE). For information about recycling options, check
the Support/Service section of the Tektronix Web site (www.tektronix.com).

Battery Recycling. This product may contain a lithium ion (Li-ion) rechargeable battery, which must be recycled or disposed of
properly. Please properly dispose of or recycle the battery according to local government regulations.

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, the Electronics Industries
Alliance (www.eiae.org) for disposal or recycling information.
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Environmental Considerations

Perchlorate Materials. This product contains one or more type CR lithium coin cell batteries. According to the
state of California, CR lithium coin cells are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Transporting Batteries
The lithium ion rechargeable battery pack in this product contains less than 8 grams of equivalent lithium content, with individual
cells containing less than 1.5 grams of equivalent lithium, as measured by International Civil Aviation Organization (ICAO)
standards. Consult your air carrier for applicability and determination of any special lithium ion battery transportation requirements.

Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS Directive.
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Preface

Preface
This manual describes the installation and basic operation of the RF Scout Interference Hunter. For more detailed information on
individual measurements, tap the underlined link text on measurement screens to open the online help for those topics.

Key Features
The RF Scout Interference Hunter is a rugged, multi-standard spectrum analyzer and interference mapping tool optimized for field
use. Key features include:

Interference hunting functions that help find interference quickly

Spectrogram display for detection and logging of intermittent signals

iMap integrated measurement mapping for on-site analysis of interference and coverage problems

Signal strength, AM/FM demodulation, and noise floor measurements

Scanners or code analyzers for GSM/GMSK/EDGE, UMTS/W-CDMA/HSDPA, cdmaOne, cdma2000, 1xEV-DO, TD-SCDMA,
and iDEN signals

Multipath signal analyzer for W-CDMA signals

User-defined channels for taking general measurements and channel scans

Macro editor for creating collections of measurements to take in the iMap window

PN Sync function for displaying 1xEV-DO and cdma2000 PN offsets in areas that do not have GPS signal availability
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Preface

Documentation
To read about Use these documents
Installation and operation (overviews) RF Scout Interference Hunter Quick Start User Manual. The quick start user manual

contains general information about how to put your instrument into service, guides to
user interface controls, and application examples.

Help using the application Online Help. The online help is context sensitive, displaying information appropriate
for the active screen or the selected help text. (See page 25, Getting Help.)
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Preface

Software Upgrades
Periodic software upgrades may become available. The software is only operational if you have a valid option key for the specific
application module and serial number.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Click Software Downloads on left side of the screen to link to the Software Downloads Web page.

3. Enter the product name or model number in the Search by keyword field and click Go.

4. Scroll through the list and select the appropriate link for your instrument to show more information or to download the software.

The instructions to perform the software upgrade are in the readme.txt file that is part of the software download.

Conventions Used in This Manual
The following icons are used in this manual:

Sequence
Step

Front panel
power

Connect
power
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Preface

Preventing Personal Injury from Lightning

WARNING. To prevent personal injury from the effects of lightning, exercise the following precautions when using this product:

Before connecting this product to any source
Check your local weather forecast for the possibility of thunderstorms or lightning.

If weather conditions could allow thunderstorms or lightning to develop, be sure to visually check the sky and weather
conditions in your area frequently.

If you can hear thunder or if you see lightning, do not connect this product to any source which may be exposed to the
effects of lightning.

Use your own good judgement and common sense. You must protect yourself from the effects of lightning.

You must assume that hazardous voltages will be present on exposed surfaces of this product if it is connected to a source
exposed to lightning. The insulation of this product will not protect you from these hazardous voltages.
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Preface

Do not connect this product to any source which might be subject to the effects of lightning
If thunderstorms or lightning are in your vicinity:

When weather conditions that could lead to lightning activity exist in your area, you could be at risk of a lightning strike
before the cloud is close enough for you to hear thunder or see lightning.

When lightning strikes a structure or facility, current travels through rebar, concrete, pipes, cables, vent stacks, and electrical
system.

Lightning can induce electric and magnetic fields into structures and portions of wiring. The length of a conductor affected by
the magnetic field of a lightning strike may exceed two miles.

Be alert and aware of the effects of lightning
When lightning strikes a conductor, which in turn introduces the current into an area some distance from the ground strike point,
equipment can be damaged and personnel injured if they become an indirect path in the completion of the ground circuit.

Conductors such as the braided shields of cables or unshielded wires will have significant transient currents flowing in them
in regions exposed to the electric field effect of lightning.

Induced voltages may cause breakdown of insulation in wiring at connectors and in electrical components or breakdown of air.
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Installation

Installation
Carefully unpack your instrument and verify that it includes the standard accessories.

RF Scout Standard Accessories
Accessory Tektronix part number
NetTek Y400 Analyzer Platform Y400
NetTek YBT250 Field Transmitter & Interference Tester Application Module YBT250
AC Power Adapter 119-6984-xx
Lithium-Ion Battery 146-0151-xx
NetTek Y400 Analyzer Setup Reference 071-1430-xx
RF Scout Interference Hunter Quick Start User Manual 071-1901-xx

Your instrument may also include optional accessories. Verify that the optional accessories you ordered are included with your
instrument. For a current list of accessories, upgrades, and options, including service options, available for your instrument,
visit the Tektronix Web site, www.tektronix.com.
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Installation

Operating Considerations
AC Adapter Input voltage and current: 100 V - 240 V AC, 1.8 A

Input frequency: 47 Hz to 63 Hz
Output voltage and current: 24 V DC, 3 A

Dimensions Height: 25 cm. (9.75 in)
Width: 33 cm. (13 in)
Depth: 9 cm. (3.5 in)

Weight 5.52 kg (12.125 lbs) (with one battery)
Temperature Range Operating: 0 °C to +50 °C specified performance, –10 °C to +50 °C typical

Nonoperating: –40 °C to +60 °C
Humidity Operating: 5% to 95% Relative Humidity (RH), noncondensing: up to +30 °C

Nonoperating: 5% to 45% Relative Humidity (RH), noncondensing: +30 °C up to +50 °C
Altitude Operating: Up to 4,600 m (15,092 ft.)

Nonoperating: Up to 15,240 m (50,000 ft.)
RF Signal Input Input frequency range: 30 MHz to 2500 MHz

Coupling: AC
Input impedance: 50 Ω (nominal)
Maximum input power without damaging instrument: 50 W CW or peak envelope power
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Cleaning
Clean the exterior surfaces of the instrument with a dry lint-free cloth or a soft-bristle brush.

Use a cloth or swab moistened with deionized or distilled water, or a 75% isopropyl alcohol solution for more stubborn stains, to
clean the instrument or touch screen; use just enough moisture to dampen the cloth or swab.

Use a gentle amount of force when cleaning the touch screen.

CAUTION. Do not get moisture inside the instrument during exterior cleaning.

Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument.

Do not spray liquids directly on the instrument or touch screen.

Do not use abrasive cleaners, or chemical cleaning agents that contain benzene, toluene, xylene, acetone, or similar solvents; they
can damage the instrument or touch screen. Do not use commercial glass cleaners to clean the touch screen.

Do not scrub the touch screen with excessive force while cleaning.
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Connecting the AC Adapter
1. Lift the instrument strap to expose the

power adapter connector.

2. Connect the AC power adapter to the
instrument.

3. Connect the AC adapter to a
properly-grounded AC power source
using the provided power cord.

4. Charge the batteries before using the
instrument on battery power for the first
time. (See page 5, Charging the Batteries.)

4 RF Scout Quick Start User Manual



Installation

Charging the Batteries
Charge the batteries before using the instrument on battery power for the first time. Batteries are partially charged and calibrated
at the factory. A calibrated battery allows the instrument to more accurately estimate how long the application modules can
operate before the instrument automatically powers off. The front-panel BATTERIES charge status indicator turns off when
charging is complete.

Approximate charge time

Number of batteries Instrument powered on Instrument powered off
1 8 hours 3 hours
2 16 hours 6 hours

NOTE. These are typical numbers for batteries that are low but not completely discharged. Newer-model instruments can contain
higher-capacity batteries, resulting in increased run time and longer charge time.

For more information on battery charging, battery calibration, and instrument power management, see the instrument Online help:
Start > Help > Tektronix Basics > Power Management.
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Powering On and Off the Instrument, and Functional Verification
1. Tap the On/Standby button to power on

the instrument.
The instrument WindowsCE Status bar
shows the Battery icon when the instrument
is operating on battery power and the
External Power Connected icon when the
instrument is operating with an external
adapter.
To power off the instrument, tap the
On/Standby button again.
For information on the instrument
on/standby power modes, see the Online
help: Start > Help > Tektronix Basics >
Shutting Down the Instrument.

2. For functional verification, watch the
screen. Verify that the instrument does
not display any power-on diagnostic error
messages.
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Touch Screen Concepts
The instrument user interface is based on touch-screen technology. Instead of using physical button and knob controls to select
functions, set values, and take measurements, you tap (touch) virtual controls on the instrument screen. Virtual controls behave
the same way as physical controls.

The following are touch screen terms used in this manual:

Term Description Equivalent mouse operation
Stylus The physical object you use to touch the screen. A stylus is either

your finger or an appropriate plastic-tipped stylus. Do not use any
metal-tipped objects or pens for a stylus, as they can damage
the touch screen.

The mouse pointer.

Tap Touch the screen briefly with the stylus. Selects the item on the
screen.

The left mouse button.

Drag Press gently on the screen with the stylus, drag the stylus to a
new position, and then raise the stylus from the screen. Moves an
item or selects an area.

Drag (hold down the left mouse
button, move the mouse, and then
release the button).
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Calibrate the Touch Screen
Before using the instrument for the first time, calibrate the touch screen display to respond correctly to your taps.

1. Tap Start > Settings > Control Panel to
open the Control Panel screen.

2. Double-tap the Stylus icon on the Control
Panel screen.

3. In the Double-Tap tab, double-tap the
checkerboard grid at a comfortable speed
with your stylus or finger to set the tap rate.

4. Double-tap the test icon to verify your
settings.
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5. Tap the Calibration tab and read the
instructions.

6. Tap the Recalibrate button to open the
Cursor Position target screen.

7. Follow the target screen instructions.
When the position target disappears, touch
anywhere on the screen to return to the
Calibration tab.

8. Tap OK to save calibration settings.
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Starting the RF Scout Application
If purchased with preloaded software, RF Scout starts automatically when you power on the instrument. If RF Scout does not start
automatically, or you have stopped the application, use either of the following methods to start the application:

Double-tap the RF Scout icon on the
instrument screen

Select Start > Programs > NetTek >
RF Scout

The instrument opens the RF Scout application.
The Microsoft WindowsCE taskbar displays a
button for each running application. To bring
the RF Scout to the front of the screen, tap the
RF Scout button in the taskbar.

NOTE. You cannot run RF Scout application at the same time as the YBT250 application. However, you can run RF Scout and the
YBA250 application module measurements at the same time as long as you are not measuring Insertion Gain/Loss.
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Setting Display Colors
You can change the color scheme used in the instrument display. The color schemes optimize the display colors for use in different
environments (outdoors or indoors) and for better printing quality on black and white (monochrome) printers.

1. Select Tools > Options.

2. Tap the Preferences tab.

3. Tap the Color Scheme list field and select
a display color scheme.

4. Tap OK.

5. Select File > Exit to close the application.

6. Restart the application to enable the
changed color scheme.
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Enabling Signal Standards
Before you begin using the instrument, you must enable (select) the signal standards that you want to measure. You can only take
measurements on enabled standards.

1. Select Tools > Options.

2. Tap the Signal Standards tab.

3. Tap the name of the standard in the Signal
Standards supported list that you want
to enable. Drag the stylus to select two or
more contiguous standards.
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4. Tap the Add >> button to add the selected
standard(s) to the Signal Standards
selected list.

5. Tap OK. The enabled standards are now
selectable from the main window Signal
Standards drop-down list.

NOTE. Limiting the number of enabled standards to just those that you regularly test makes it easier and faster to select a
standard from the Signal Standard drop-down list.
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Getting Acquainted with Your Instrument

Getting Acquainted with Your Instrument
Instrument Elements

1. NetTek Y400 Analyzer Platform.

2. Battery compartment.

3. NetTek YBT250 Application Module.

4. Input/Output ports. (See page 17,
Input/Output Connectors (NetTek Y400
Platform).)

5. PCMCIA card ports.

6. Power and Status panel. (See page 16,
Power On/Standby and Status Panel.)

7. External adapter power connector. (See
page 4, Connecting the AC Adapter.)

8. Touch screen.
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Power On/Standby and Status Panel
1. Power On/Standby button. Push to

power on or off the instrument. For
more information, access the online help:
Start > Help > Tektronix Basics >
Shutting Down the Instrument.

2. Reset button. Performs a hardware reset;
all programs and data loaded into volatile
memory are erased. Generally only used
to recover from a system lock-up. Use a
thin probe to push the reset button.

3. Power/Display status. Green indicates
that the instrument is powered on. Amber
indicates that the instrument is powered on
but the display is turned off (to conserve
power).

4. Battery status. Green indicates that the
instrument is connected to an external
power source and is charging installed
batteries. Red indicates a low battery.
No color indicates that the batteries are
charged.
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Input/Output Connectors (NetTek Y400 Platform)
1. Microphone input

2. Headphone jack

3. Ethernet connector (RJ-45)

4. Serial RS-232 connector

5. PS/2 keyboard connector

6. USB Host connector

7. USB Slave connector

See the Y400 NetTek Analyzer Setup Reference document (Tektronix part number 071-1430-XX) for more information on the
NetTek Y400 Analyzer Platform.
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NetTek YBT250 Module Signal Connectors
1. Timing Input. Connects to an external

timing reference signal, such as a BTS
Even Second Clock signal, or the timing
signal from a Tektronix YBGPS1 GPS
Timing Reference.

2. Frequency Reference Input. Use an
external frequency reference signal to
improve measurement accuracy.

3. RF Input. The RF Input connects the
RF input signal source or measurement
antenna to the instrument.

Microsoft WindowsCE Elements
The Microsoft WindowsCE user interface is similar to other Microsoft Windows operating systems. You use standard Microsoft
Windows operations to start (run) applications, select and move objects, and open folders or files. For more Microsoft WindowsCE
information, access the online help: Start > Help > WindowsCE Basics.

The Status area, located at the bottom right of the screen, contains icons that display important information about the instrument
power status. For an explanation of all status area icons, access the online help: Start > Help > WindowsCE Basics >
Understanding Taskbar Icons.
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The User Interface
1. Command bar. (See page 20, The

Command Bar.)

2. Tuning controls. (See page 21, The
Tuning Controls.)

3. Measurement results. Shows the
waveform displays and measurement
results. The appearance of this area
changes depending on the selected
measurement mode and measurement
type.

4. External signal status buttons. (See
page 22, The External Signal Status
Buttons.)

5. Measurement mode buttons. (See
page 23, The Measurement Mode
Buttons.)

6. Parameter entry controls. (See page 24,
The Parameter Entry Controls.)
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The Command Bar
Contains the application menus, as well as buttons for saving measurement results, opening the application setup dialog box,
and running/pausing the application.

Element Description
Menus. See the Online help topic Menus for information about the menu functions.

Save Results button. Saves the current measurement acquisition to a file. See the Online help
topic The Save & Export Tab for how to set file save parameters.

Log Measurements button. Enables automatically taking and saving a measurement at specified
time intervals. See the Online help topic The Logging Dialog Box for how to set the time interval
between measurement acquisitions.
Edit button. Opens the Setup dialog box that contains instrument settings tabs. See the Online
help topic Setup Tabs for information on the setup dialog tabs.
Open button. Shows the Open dialog box that lists saved instrument setup files to load and
configure instrument settings. See the Online help topic The Setup Menu Tab for directions on how
to switch the button between the Edit and Open modes.
Run/Pause button. Runs or Pauses the current measurement acquisition.

Help button. Opens the online help. Online help is context-sensitive and normally displays a
help topic related to the current measurement mode or screen. If the current screen is not
context-sensitive, the instrument opens the Online help at the main help menu. Use the index, or do
a word search, to locate specific information.
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The Tuning Controls
Selects the signal standard, signal direction (uplink or downlink), measurement channel, and measurement frequency.

Element Description
The Signal Standard drop-down list displays the enabled signal standards from which you
select a standard to measure. (See page 12, Enabling Signal Standards.)

The Downlink and Uplink buttons change the Freq (MHz) setting to the forward link (downlink)
or reverse link (uplink) frequency of the current signal standard and channel. For W-CDMA
signals, these buttons set the corresponding forward or reverse channel number.
The Channel button sets the channel number. The field next to the button shows the current
channel number. Tapping the button opens the numeric keypad, with which you enter
a channel number.
The current signal standard defines the available channel numbers. Setting the channel
number sets the instrument measurement frequency to the appropriate value for the selected
signal standard and up or downlink mode setting.
The Freq (MHz) button sets the Measurement Frequency. The field next to the button
shows the frequency. Tapping the button opens the numeric keypad, with which you enter
a frequency value.
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The External Signal Status Buttons
Indicates status and sets GPS, measurement reference frequency source, input signal attenuation or amplification values, and
PN Sync parameters.

Element Description
The GPS status button indicates the GPS signal lock status of an attached GPS receiver. The color indicates
the GPS receiver signal lock status. Tap this button to open the GPS setup tab. See the Online topic The GPS
Tab for more information.
The Measurement Reference Frequency status button indicates the measurement frequency reference source. Tap
this button to open the Inputs tab. Use this button if you connect an external measurement reference frequency
source to the instrument.
The available measurement reference frequency sources are the internal instrument frequency reference (F INT),
an external reference (F EXT), or a GPS-derived timing reference from the Tektronix YBGPS1 GPS Timing
Reference (F GPS). See the Online topic The Inputs Tab for more information.

The RF Input Signal Gain/Loss status button shows the external attenuator or amplifier status. Tap this button to
open the Inputs tab where you can set the input signal amplification or attenuation values. Use this button if you
connect an attenuator or amplifier to the input signal. See the Online topic The Inputs Tab for more information.
When PN Sync is enabled, the RF Input Signal Gain/Loss status button is replaced with the PN Sync status button.
The color indicates the PN Sync availability status. Tap this button to open the PN Sync Settings dialog box.
See the Online topic PN Sync for more information.
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The Measurement Mode Buttons
The Measurement Mode buttons select the type of measurement or operation to perform.

Element Description
Select the Spectrum Measurements button to take spectrum, spectrogram, signal strength, audio
demodulation, and noise floor signal measurements.

Select the Channel Measurements button to take code power, codogram, EMF, and channel
scanner/analyzer measurements.

Select the iMap Mapping button to open the Map tool and link instrument measurements to
a location on a map. Use for graphically recording measurements to help analyze signal
characteristics, locate interference, and save measurement/location information.

Select the Signal Measurements button to take signal measurements including RF power, signal
quality, occupied bandwidth, carrier frequency, power vs. time, and others.
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The Parameter Entry Controls
The Parameter Entry controls (keypad and knob) let you enter or change numeric values in selected fields. You can use either tool
to enter or change a value.

Element Description
The input control field shows the label for the field and the current value of the selected field
or object.

Tap the keypad button to display a keypad in which to enter a value in the selected field. The
keypad content changes to show the available entry functions for the selected item.

The knob control lets you scroll through and select from all available values.

1. Drag the knob circle left or right to quickly scroll through all available values and select a value.

2. Tap the arrows on the top half of the knob icon to step the value in large increments. The
increment value depends on the value type (channel or frequency).

3. Tap the arrows on the bottom half of the knob icon to step the value in single unit increments.
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Getting Help
The application includes a comprehensive Online help system. You access Online help using the following methods:

Online help element Description
Help button. Located at the top right of the screen, this button is available all the time. Tap this
button to display a help topic that is relevant to the current measurement screen.
If the current screen is not context-sensitive, the application opens the Online help at the main help
menu. Use the index link, or do a word search, to locate specific information.
Help link text. On measurement screens, underlined blue text is help link text. Bold help link text at
the top of a measurement screen opens a topic describing how to take that measurement. Help
link text that is located next to a measurement or setting opens a topic relevant to that particular
measurement or setting.

Contents Index Online help Content and Index links. Every Online help topic includes a Contents and Index link.
If the topic does not contain the information you were seeking, use these links to locate specific
information.
Tab or dialog box help button. This button is displayed at the bottom of many setup tabs or dialog
boxes, and opens an Online help topic relevant to that tab or dialog box.
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Operating Basics
Setting Up to Take a Measurement

Perform the following steps to set up the instrument to take a measurement. These steps apply for most types of measurements.

1. Connect a signal to the instrument.

2. Tap the Signal Standard List arrow button
to open the signal standard list.

3. Tap a signal standard to select it. This
signal standard is used for measurements
until you change to a different signal
standard. (See page 12, Enabling Signal
Standards.)

4. Tap the appropriate signal Uplink or
Downlink button for the measurement that
you are taking.
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Entering a Channel:

NOTE. You only need to enter a channel or a frequency; you do not need to enter both values.

5. Tap the Channel button to open the
keypad.

6. Enter a channel number.

7. You can also tap the List button to display
a list of available channels from which
to select a value. Channel numbers are
defined by the current signal standard.
If there is a corresponding frequency for the
entered channel number, the instrument
displays that frequency in the Freq (MHz)
field.
If you enter a channel number outside the
valid range, the instrument sets the channel
number to the closest valid number.

8. Tap OK to close the keypad or channel list
and set the channel value.
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Entering a Frequency:

NOTE. You only need to enter a channel or a frequency; you do not need to enter both values.

9. Tap the Freq (MHz) button to open the
keypad.

10. Use the keypad to enter a frequency value.
This sets the center frequency of the
measurement.
If there is a corresponding channel number
for the entered frequency, the instrument
displays that channel number in the
Channel field.

11. Tap a frequency unit button (such as GHz
or MHz) to close the keypad and set the
frequency value.
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Selecting a Measurement Mode:

12. Tap a measurement mode button. (See
page 23, The Measurement Mode Buttons.)

13. For Spectrum and Channel measurements,
select the tab of the measurement that you
want to take.

14. For Signal measurements, tap the Select
Measurement button, then tap the
measurement that you want to take.
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Setting Additional Measurement
Parameters:

15. Tap the Edit button to open the Setup
dialog box.

16. Tap the tab of the measurement parameters
that you want to set.

17. Select or enter the measurement parameter
values.

18. Tap OK to close the Setup dialog box
and enable the measurement parameter
settings.

30 RF Scout Quick Start User Manual



Operating Basics

Spectrum Measurements
Displaying a Spectrum Waveform

1. Set the instrument to measure a signal of
interest.(See page 26, Setting Up to Take a
Measurement.)

2. Tap the Spectrum Measurement button.

3. Tap the Spectrum tab.

4. Tap the AutoLevel button.
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5. Set spectrum display parameters.
Available spectrum parameters include
the frequency span, resolution bandwidth
(RBW), signal attenuation value, graph
reference and division values, start and
stop frequencies, and marker positions.
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6. For example, to change the graph
reference and division values, tap the Ref
Lvl field or the Vertical Scale field to select
it.

7. Use the Parameter Entry controls to enter
or change the scale setting.

8. Use Markers to take measurements on
a waveform. (See page 34, Spectrum
Waveform Markers.)

NOTE. Tap the Edit button to open the Setup dialog box and set additional measurement parameters. Available parameters
depend on the current signal standard and measurement type. Not all measurements have setup parameters.
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Spectrum Waveform Markers
Markers are visual icons that you position on a spectrum waveform to measure signal frequency and level values. You use the
markers to measure the value at a particular point on a waveform (Absolute Marker Values), or measure the difference between two
markers (Delta Marker Values). The markers follow the waveform level changes.

Each marker icon has an associated marker readout, displayed at the bottom of the Spectrum display. The marker readout shows
the marker icon symbol, the marker name, and the frequency and level values for the marker.

There are a maximum of seven markers available; the Trace marker (Tra), and M1 through M6. The Tra marker changes the
measurement frequency to the location you select on the waveform. The M1 through M6 markers read the waveform frequency and
level at the location they are placed. Tra, M1, and M2 markers are shown by default.

Turning Markers On and Off.

1. Tap View.

2. Tap Markers to turn marker display on or
off.
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Selecting Which Marker Readouts to Display.

1. Select View > Marker Setup... to display
the Markers dialog box.

2. Tap to enable or disable individual markers
and set the marker mode:
On enables or disables the selected
marker.
Front Trace places the marker on the front
trace.
Trace 1 and Trace 2 keep the marker on
the specified trace regardless of which
trace is in front. Use this mode to compare
two waveform traces.
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3. Tap OK. The instrument shows the center
frequency readout plus three marker
readouts at a time (in Absolute Marker
Readouts mode) or the center frequency
readout plus two marker readouts at a time
(in Delta Marker Readouts mode).

4. Tap the marker readout scroll buttons
to scroll through the enabled marker
readouts.
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Setting the Marker Measurement Mode.

1. Tap View.

2. Tap Delta Marker Readouts to enable
marker readouts to display the difference
(delta) between the frequency and level
values at marker M1 and the other markers.
While in Delta Marker Readouts mode, all
marker readouts are relative to marker M1.

3. Tap Absolute Marker Readouts to enable
marker readouts to display the actual
frequency and level values of the signal at
the marker position on the waveform.
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Add or Move a Marker on a Waveform.

1. Tap View.

2. Tap Measurement Frequency Cursor.

3. Tap the marker readout of the marker that
you want to add or move on the spectrum
waveform. The marker readout border
darkens to indicate that it is selected.

4. Tap the waveform where you want to add
or move the marker. The marker is placed
on the waveform and the readout shows
the signal values at the new location.

5. Use the Parameter Entry controls to
fine-tune the position of the marker on the
waveform.
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Comparing Spectrum Waveforms (Traces)
You can compare two live waveforms (derived from the single RF input signal), the RF input signal waveform and a saved
waveform, or two saved waveforms.

Selecting Waveform Traces.

1. Tap the Traces button to toggle between
Trace 1 and Trace 2.
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Comparing Live and Saved Waveform Traces.

1. Set the instrument Spectrum parameters
to display the waveform of interest. (See
page 31, Spectrum Measurements.)

2. Tap the Traces button to select Trace 1.

3. Tap the Trace 1 list button and then tap
a trace type to select it. The instrument
applies the selected operation to the input
signal and displays the results as the trace
1 waveform.

4. Tap the Traces button to select Trace 2.
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5. Tap the Trace 2 list button and then tap
a trace type to select it. The instrument
applies the selected operation to the input
signal and displays the results as the trace
2 waveform.
The figure shows Trace 1 as an Normal
waveform and Trace 2 as a Min Hold
waveform. You can use markers to make
measurements between the waveforms.

6. To compare a saved waveform to a live
waveform, tap the Trace 2 list button and
then Saved. The instrument opens the
Trace 2 & Mask setup tab.

7. Tap Saved Trace.

8. Tap the Browse button to navigate to and
select the saved waveform to open.

9. Tap OK. The instrument displays the saved
waveform as the Trace 2 waveform.

NOTE. The current instrument measurement settings must match the instrument settings used to capture the saved waveform in
order to compare both waveforms.
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Comparing Two Saved Waveform Traces.

NOTE. Waveform traces are saved with the settings in effect at the time the trace is saved. When a saved trace is displayed, the
stored settings values are shown for reference, though no actual instrument settings change. As soon as you tap the Run button to
return to making new acquisitions, the display settings are restored to what they were before the saved trace was opened.

1. Select File > Compare Saved.

2. Navigate to and select the first waveform
file to load.

3. Tap OK to open the Select second result
file to compare dialog box (it looks exactly
the same as the first dialog box).
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4. Navigate to and select the second
waveform file to load.

5. Tap OK to enter the second file and close
the dialog box. The instrument displays
both waveforms.

6. After viewing the waveforms, tap the Run
button to return the instrument to taking
measurements.
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Display a Spectrogram
A spectrogram shows how the signal level changes over time. It can be very useful in identifying intermittent signals.

1. Set the instrument to display the spectrum
waveform of interest.(See page 31,
Displaying a Spectrum Waveform.)

2. Tap the Spectrogram tab.

3. Tap the Updates button to display a
dialog box where you can change the
spectrogram measurement update rate,
and enable automatic saving of data
when a screen is full (80 data record
acquisitions).

4. The Data Record readout shows the
time and date stamp of the spectrogram
record located at the record cursor (white
horizontal line). To change the record
cursor position, tap the Data Record field
and use the keypad or knob to move the
record cursor.
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5. Tap the Split Screen button to switch
between a full-screen spectrogram display
and a split spectrum and spectrogram
display.
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Locating the Direction of a Signal

1. Connect a directional antenna to the
instrument.

2. Set the instrument to display the spectrum
waveform of interest. (See page 31,
Displaying a Spectrum Waveform.)

3. Tap the Strength tab.

4. Tap the trace of the interfering signal to
set the measurement frequency. You
can use the keypad or knob to adjust the
measurement frequency.

5. Point the directional antenna in different
directions. As you change the direction of
the antenna, the audible tone and beep
(if selected), and the Strength bar graph
change to indicate signal strength. The
signal of interest is located in the direction
that results in the strongest signal.

6. Tap Fast Update to improve audio tone
response, at the expense of a reduced
screen update rate.
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Listening to the Audio Content of a Signal

1. Set the instrument to display the spectrum
waveform of interest. (See page 31,
Displaying a Spectrum Waveform.)

2. Tap the Audio tab.

3. Tap the trace of the interfering signal to
set the measurement frequency. You
can use the keypad or knob to adjust the
measurement frequency.

4. Tap the different Demodulation types and
listen to the resultant audio (if any). A
station ID can be particularly helpful when
the interfering signal is a radio or broadcast
television station. You may also be able
to discriminate between possible sources
by listening to the characteristic sounds
of paging, video, control signals or the
harmonics of other common signals.
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Taking a Noise Floor Measurement
Noise floor measures all the RF Power coming into the receive antenna within the frequency band of the selected channel. The
noise floor is the power integrated across the selected channel. To make an accurate measurement, you must measure the noise
floor on a disabled channel (a channel that is not carrying live traffic).

1. Connect a signal from a BTS receiver test
port to the instrument.

2. Set the instrument to display the spectrum
waveform of interest. (See page 31,
Displaying a Spectrum Waveform.)

3. Tap the Reverse (up) link button.

4. Tap the Noise tab.

5. Tap the trace of the interfering signal to
set the measurement frequency. You
can use the keypad or knob to adjust the
measurement frequency.
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Channel Measurements Mode
Channel measurements mode includes measurements for Code Power, Codograms, EMF, Channel scanners, and Scrambling/Sync
Code Analyzers. Code Power and Codogram are also available in the Signal measurements mode.

Taking a Channel Measurement
The following procedure assumes that you have already set up the measurement. (See page 26, Setting Up to Take a
Measurement.)

1. Tap the Channel Measurement button.

2. Tap the tab of the measurement that you
want to take. The active signal standard
determines the available measurements.
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3. Tap available measurement parameters
and use the Parameter Entry controls to
set measurement parameter values.

4. Tap the Edit button to open the Setup
dialog box and set additional measurement
parameters in the dialog box tabs.
Available parameters depend on the
current signal standard and measurement
type. Not all measurements have setup
parameters.

50 RF Scout Quick Start User Manual



Operating Basics

1xEV-DO and cdma2000 PN Scanner Tadd/Tdrop Markers
Tadd and Tdrop are horizontal markers that you can set on 1xEV-DO and cdma2000 PN Scanner measurements to visually
indicate add or drop signal power levels. Using these markers lets you quickly identify PN codes that are within defined add or
drop ranges. The Tadd/Tdrop horizontal markers are visual aids only, and do not cause the instrument to display warnings
when signals are above or below the set levels.

1. Select View > PN Scanner Tadd/Trop
Markers to display the markers on the
scanner measurement graph.

2. Tap the Tadd or Tdrop readout and use
the keypad or knob control to change the
marker level value.

See the Online help topic Take a Scan Measurement for information on scanner measurements.
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Creating Custom Scanner Code Labels
The Scanner Code Label Editor lets you add unique labels to the graphs of 1xEV-DO/cdma2000 PN offset and W-CDMA scrambling
code scanners. Once you have created labels, tapping a bar graph of a PN offset or scrambling code displays the label assigned to
that PN offset or scrambling code, directly below the graph. Using labels lets you quickly identify the source of a particular code.

1. Select View > PN Offset Labels or
View > Scrambling Code Labels to
enable viewing scanner labels on the
scanner measurement graph.

2. Tap a bar graph plot to display the
custom label assigned to that PN offset or
scrambling code.

See the Online help topic Scanner Code Labels Overview for information on creating, saving and using custom scanner code labels.
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iMap Measurement Mapping Mode
iMap integrates interference mapping, coverage mapping, in-building mapping, outdoor mapping, and provides an integrated
solution for field interference and coverage problems in one instrument.

Using iMap is as easy as selecting a measurement and touching the displayed map where you want the measurement to be placed.
Measurement icons are color coded to indicate if the measurements have passed or failed limit tests. You can also add a direction
arrow to a measurement to indicate the direction the antenna was pointing when you took a measurement.

You can load scanned bitmap files as maps for in-building mapping, or use GSF and MIF map file formats for outdoor maps.
Using GSF or MIF map files lets you use a connected GPS receiver (such as the Tektronix YBGPS1 GPS Timing Reference) to
automatically place measurements at your current location.

You can save maps and associated measurement results data to common file formats such as CSV or MapInfo. Saving maps
and measurement results lets you analyze measurement data (position, value, and direction) and prepare reports to help resolve
interference problems.

1. To start the iMap tool, tap the iMap button.
When you open the iMap tool for the first
time, the screen displays the message No
map loaded. Otherwise, iMap displays the
last-loaded map.
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Map File Concepts
The iMap tool uses two types of maps; Grid and Image.

Grid Maps. Grid maps have geophysical latitude and longitude coordinate references embedded in the map file. RF Scout uses
grid maps, along with an active GPS receiver, to place measurements on a map at your current geophysical position. RF Scout can
load both GSF- and MIF-format grid map files. You need to convert non-GSF or MIF grid maps to GSF format before you can load
them into the iMap tool. The iMap Converter program also lets you create grid maps from image files, the Google Earth application,
or the Microsoft MapPoint application. (See page 67, The iMap Converter Program.)

Grid maps require an active GPS receiver to correctly link measurements to geophysical map locations. An active GPS receiver is a
receiver that is locked to four or more satellite signals and is providing the RF Scout with accurate GPS location data. If you load a
grid map and a GPS receiver is either not connected or does not have a good satellite signal lock, the instrument considers the
grid map as an image map.

Image Maps. Image maps do not have any geophysical latitude and longitude references embedded in the map file. An image
map is a graphical image, such as a scanned building floor plan or aerial photograph, to which you can attach measurements at
the point where you tap the screen.

Converting Files to Maps. The iMap Converter, a program that is downloadable from the Tektronix Web site, lets you convert
image files (BMP, JPEG, GIF, TIFF or PNG file) into GSF format image map files, convert image files to grid maps, and create grid
maps from Google Earth or Microsoft MapPoint applications. (See page 67, The iMap Converter Program.)
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Loading a Map into RF Scout
You need to load a map before you can use the RF Scout iMap tool.

1. With iMap open, select File > Load Map.

2. Navigate to and select the map file to load
(Bitmap, GSF or MIF format).

3. Tap Open. The iMap application loads the
map on the screen.
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Mapping a Measurement
The following procedure requires that you have already set up the measurement. (See page 26, Setting Up to Take a
Measurement.) You must have also loaded a map file. (See page 55, Loading a Map into RF Scout.)

1. Tap the Single Measurement button.

2. Tap an iMap measurement button.
Available measurements depend on
the current signal standard. The
selected measurement is displayed in the
Measurement Thumbnail area.
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3. Tap the map:

If a connected GPS receiver is active,
and you are using a grid map, a
single measurement is placed at the
current GPS latitude and longitude
coordinates.

If a GPS receiver is not active, or if
you are using an image map (such
as a building floor plan), a single
measurement is placed where you
tapped the map.

4. You can select a different measurement
button, and then tap the map to add a
new measurement to the map. Multiple
measurement icons at the same location
stack on top of each other.
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5. To move an icon, tap the Select button
and then touch and drag the icon to a
new position. If the measurement was
part of a stack of measurements (such as
measurements created by a macro), then
iMap moves the topmost icon in the stack.
If the icon is moved to a new stack of
measurements, then the icon is placed in
the stack in time-of-measurement order.

NOTE. To add measurements at a new location on a grid map with an active GPS receiver, you must physically move to the
new location.

NOTE. You can move measurement icons on an image map, or on a grid map with the GPS receiver inactive. Attempting
to move an icon on a grid map with an active GPS receiver causes iMap to drag the map and its measurement icons to a new
position on the screen; the measurement icons are not moved.

When a GPS receiver is not active, you can move any measurement icon. This includes moving measurement icons that were
placed on the map while in GPS mode. iMap does not reposition moved GPS-related measurement icons back to their original
geophysical position on a map when the GPS receiver is active.
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iMap Measurement Icons
The iMap application uses icons on the map to represent a measurement taken at that location. There are three types of
measurement icons: large, small, and flag. The large and small icons have individual icon graphics for each measurement type that
they represent. The flag icon is a simple small flag, and is used for all measurement types. See the RF Scout Online help topic
iMap Measurement Map Icon Types for more information.

To select which type of measurement icon to display on a map, tap the View menu item and select the icon type to use. All
current icons on the map are changed to the selected icon type.

You can set the measurement icons to color their border to indicate the signal or measurement range value (from Best to
Unacceptable). Setting the icon border color lets you quickly evaluate the relative value of a measurement. To set icon color
ranges, tap Tools > iMap Measurement Settings. See the RF Scout Online help topic Setting The iMap Measurement Icon
Colors for more information.

You can perform various actions on measurement icons, including view the measurement results of an icon, move the icon, delete
the icon, and attach a measurement direction arrow to an icon. See the following sections, and the RF Scout Online help topic
View Map Measurements, for more information.
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Viewing and Deleting Icon Measurements
To view or delete the measurement results associated with an iMap measurement icon:

1. Tap the iMap Select mode button.

2. Tap a measurement icon to open the Map
Measurements dialog box.

3. Tap the measurement of interest in the list.

4. Tap Open to open the measurement
screen for the selected measurement.
Then tap the iMap button to return to the
iMap screen.

5. To delete the selected measurement, tap
the Delete button If there are multiple
measurements that you want to delete,
repeatedly tap Delete.

6. Tap OK to close the dialog box.

NOTE. You can also double-tap on a measurement icon to open the measurement window for that measurement. If there are
multiple measurements at a location, double-tapping an icon displays the results for the measurement icon that is at the top of
the list.

To delete all the measurement icons from a map, select File > Clear All Measurements.
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Draw a Measurement Direction Arrow
The iMap direction arrow function lets you draw an arrow on a mapped measurement icon. You can use the arrow to indicate the
direction your antenna was pointing when you took a measurement.

1. Tap the Measurement Direction button.

2. Tap and drag from the center of a
measurement icon in the direction
the antenna was pointing when the
measurement was made. iMap draws an
arrow from the measurement icon.

3. To change the arrow direction, draw a new
line. iMap replaces the existing arrow with
the new direction arrow.
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Delete a Measurement Direction Arrow

1. Tap the iMap Select mode button.

2. Single-tap the measurement icon with the
direction arrow to delete. iMap opens the
Map Measurements dialog box.

3. Tap the measurement name that has the
direction arrow to delete.

4. Tap the Remove Arrow button.

5. Tap OK. iMap closes the dialog box and
deletes the direction arrow.
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Logging iMap Measurements (Automatic Measurements)
Logging measurements lets you automatically map a single measurement at a set time interval or change in GPS position (with
active GPS receiver and a grid map).

NOTE. The iMap tool only maps completed measurement results. If the specified time interval is less than that required to take a
measurement, iMap ignores the specified time interval and maps results as soon as the measurement acquisition is done.
For example, if the instrument requires 20 seconds to take a measurement, but the time interval is set to 10 seconds, then
the instrument maps results every 20 seconds.

1. Tap a measurement button. Available
measurements depend on the current
signal standard.

2. Tap the Log Measurements button.
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3. Select the type of repeat measurement
to take (time interval or distance between
measurement positions).

4. Tap OK to return to the mapping screen.

5. Tap the map to start logging measurements:

For grid maps with an active GPS
receiver, tap the map at any point.
The instrument begins adding
measurement flags to the map at the
current GPS position.

For image maps or for grid maps
without an active GPS receiver, tap
the map at the measurement starting
location. The instrument begins taking
measurements, but does not display
them on the map until measurement
logging is done.
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6. Tap the map to stop measurements:

For grid maps with an active GPS
receiver, tap the map at any position.

For image maps or grid maps without
an active GPS receiver, tap the map at
the position the last measurement was
taken. Measurements are then evenly
spaced on a straight line between the
start and stop map points.

7. Tap the Single Measurement or the Select
button to exit the logging measurements
mode.
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NOTE. The iMap Log measurements function automatically sets the map view measurements mode to Measurement Flags during
logging measurement acquisition. When iMap measurement logging is done, the instrument restores the map view measurements
mode to the mode it was at before the iMap measurement logging was initiated.

If you tap the Select, Measurement Direction, or Single Measurement button while logging measurements in non-GPS mode,
iMap cancels the log measurements mode and does not draw any measurement icons on the map.

Grid maps with an active GPS receiver support logging measurements by time interval or distance change interval. Image maps, or
grid maps with an inactive GPS receiver, support logging measurements by time intervals.

You cannot place a measurement icon on any area of the map that is covered by a message banner or by the zoom and pan controls.

iMap Measurement Macros
iMap has the capability to use a macro file to take a set of sequential measurements with one operation, instead of selecting and
running individual measurements one at a time. Each macro file measurement can be unique, including measurements for different
channels, measurement settings, and signal standards. You create a macro file by using the iMap Macro Editor tool. You then load
the macro file into the instrument, and enable the macro to run with the Macro button on the iMap tool bar.

To open the iMap Macro Editor, select Tools > iMap Macro Editor. See the RF Scout Online help topic Mapping Measurements
Using Macros for complete information on creating, saving, loading, and running iMap measurement macros.
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The iMap Converter Program
Tektronix provides a map file conversion program called iMap Converter that you can download from the Tektronix Web site. iMap
Converter lets you convert graphical image files or map files to GSF-format files for use with the instrument iMap tool. Types
of images or files that you can convert include:

Bitmap, JPEG, GIF, TIFF and PNG graphical images (map images, building floor plans, aerial photographs)

Industry standard MapInfo Interchange Format (MIF), ArcInfo Shape (.shp), USGS Digital Line Graph (.opt) geophysical
coordinate maps

Other iMap Converter features include:

Easily capture images from Google Earth or Microsoft MapPoint to create geophysical (coordinate) map files for use with
GPS measurement mapping

Manually assign geophysical coordinates (latitude/longitude) to image files, such as building floor plans or screen capture map
images, to create a grid map for use with GPS measurement plotting

Combine multiple coordinate map files (other than GSF) into a single large map file

To install the iMap Converter program on a PC:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Click Software Downloads on the left side of the screen open the Software Downloads Web page.

3. Enter imapconverter (single word) in the Search by keyword field and click Go.

4. Select the iMap Converter link to download the software. Follow the installation instructions on the download page.

5. To open the iMap Converter tool on the PC, select Start > Programs > Tektronix > iMapConverter.
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6. Click the iMap Converter Help button for information on how to use the tool to convert files, add coordinates to an image file,
or create maps from Google Earth or Microsoft MapPoint.

NOTE. Bitmap files that are converted to GSF-format load faster on the instrument because the instrument does not have to do the
bitmap-to-GSF conversion in the instrument. However, it is then possible to confuse image GSF maps with grid (coordinate) GSF
files. Use a file naming convention to differentiate between GSF maps created from coordinate maps and GSF maps created
from bitmap files that do not have coordinate information.

NOTE. The MIF-format files take significantly longer to load than the GSF-format files. Tektronix recommends that you use iMap
Converter to convert MIF map files to GSF map files, rather than loading MIF files directly on the instrument.
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Signal Measurements
Taking a Signal Measurement
Signal measurements include RF channel power, peak/average, carrier frequency, occupied bandwidth, signal quality, code power,
codograms, and pilot power. Available measurements depend on the current signal standard.

1. Set the instrument to measure a signal of
interest. (See page 26, Setting Up to Take
a Measurement.)

2. Tap the Signal Measurement button.

3. Tap the Select Measurement button to
open the Select Signal Standard and
Measurement dialog box.

4. Tap the measurement button for which
you want to take measurements.
The instrument opens the selected
measurement screen.
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5. Make any necessary setting changes on
the measurement screen (if available). For
example, the cdma2000 Signal Quality
measurement lets you select the signal
type to use for measuring Signal Quality
(Pilot only or Auto detect active codes).

6. Tap the Edit button to open the Setup
dialog box and set additional measurement
parameters in the dialog box tabs.
Available parameters depend on the
current signal standard and measurement
type. Not all measurements have setup
parameters.
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Specifications
This section lists the electrical, environmental, and physical specifications of the RF Scout Interference Hunter. All specifications
are guaranteed unless labeled “typical”. Typical specifications are provided for your convenience and are not guaranteed.

Table 1: General characteristics

Characteristic Description
RF Input

Input Frequency Range 30 MHz – 2500 MHz
Input Impedance 50 ohms (nominal)
Signal Amplitude for
Modulation Measurements

–50 dBm to +30 dBm for CW-like or peak envelope power
Measurements may be outside this range but accuracy is not guaranteed

Signal Amplitude for
Spectral Display, typical

CW or peak envelope power:
–144 dBm to +30 dBm, 200 MHz to 2.0 GHz
–142 dBm to +30 dBm, 2.0 GHz to 2.2 GHz
–139 dBm to +30 dBm, 2.2 GHz to 2.5 GHz
Levels apply when using 100 Hz resolution bandwidth

Input Overload Detect >1 W (+30 dBm) CW or peak envelope power
Maximum Input Power
without Damaging
Instrument

50 W CW or peak envelope power

Coupling AC for all measurements and spectral display modes
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Table 1: General characteristics (cont.)

Characteristic Description
Maximum Working Voltage 15 V (DC + peak AC)
Spurious Input Signals To meet modulation measurement specifications:

(Total power of interest - Total power in spurious) > 35 dB
or
| Center frequency of signal of interest - center frequency of spurious signal | > 1.4 MHz
and
(Total power of interest - Total power in all spurious) ≥ –3 dB

External Frequency
Reference Input

Impedance 1500 ohms (nominal)
Input Connector 50 ohm BNC
Frequency Range Any multiple of 1 MHz up to 15 MHz inclusive, ± 1 ppm

Any multiple of 1.2288 MHz up to 19.6608 MHz inclusive, ± 1 ppm
2.048 MHz ± 1 ppm
4.8 MHz ± 1 ppm

Level Range –15 dBm to +15 dBm
dBm levels assume 50 ohm source
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Table 1: General characteristics (cont.)

Characteristic Description
Maximum Input Level
without Damage

± 3 V peak continuous

Coupling AC
Working Voltage 3 V (DC + peak AC)
Lock Time < 15 seconds

Timing Input
Impedance 10 kΩ
Minimum High Threshold 2.0 V
Maximum Low Threshold 0.8 V
Minimum High Time 10 ns
Minimum Low Time 10 ns
Maximum Input Level
without Damage

± 5 V peak continuous

Coupling DC
Timing Error ± 10 ppm
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Table 1: General characteristics (cont.)

Characteristic Description
Internal Time Base
Characteristics

Error ± 0.5 ppm drift from 0 °C to 50 °C
± 1.0 ppm aging/year
Ten minute warm-up period required to meet accuracy specification.
Users can connect the External Reference input to a frequency source and obtain a user
correction value. This value will be used to correct time base errors in measurements to
the accuracy of the external reference. The internal time base will continue to drift with
temperature and age as specified above.

Signal Path Characteristics
Phase Noise ≤ –75 dBc/Hz @ 20 kHz carrier offset
Noise Figure 1 kHz resolution bandwidth:

≤10 dB, 200 MHz to 2000 MHz
≤12 dB typical, 2000 MHz to 2200 MHz
≤15 dB typical, 2200 MHz to 2500 MHz

Displayed Average Noise
Level (DANL), typical

10 Hz RBW: –152 dBm, 200 MHz to 2000 MHz
100 Hz RBW: –145 dBm, 200 MHz to 2000 MHz
1 kHz RBW: –135 dBm, 200 MHz to 2000 MHz
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Table 2: Measurement characteristics

Measurement Description
External
Attenuation

User Selectable ON/OFF
Attenuation = –30 dB to +80 dB

Code Domain
Power (cdmaOne,
cdma2000,
W-CDMA)

Measures the power in each of the Walsh codes (64 in cdmaOne, 128 in cdma2000) used in a CDMA
signal.
Measures the power in each of (up to 512) OVSF codes used in a W-CDMA signal.

Units dB relative to Pilot Power or Total Power
Resolution 0.1 dB
Accuracy cdmaOne and cdma2000: ± 1 dB code domain power level > –20 dB relative to total power, using the

recommended TIA/EIA-IS-97-D pilot level of –;7.0 dB (20%) relative to total power.
W-CDMA: ± 1 dB Code domain power level > –20 dB relative to total power, using W-CDMA 3GPP
Test Model 3.
Reference information: ± 2.5 dB for –27 dB < CDP < –20 dB relative to total power in band classes
0-6 (cdmaOne, cdma2000).
± 2.5 dB for –27 dB < CDP < –20 dB relative to total power (W-CDMA).
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Table 3: Spectral analysis

Characteristic Description
Measurement
Frequency

Sets the measurement frequency of the display. The measurement frequency can be set by either
entering a specific frequency or by selecting a channel number.

Units MegaHertz (MHz) or Channel Number
Resolution 1 kHz 1 channel
Range 30 MHz to 2500 MHz

Frequency Span Sets the frequency range covered by the spectral display.
Units kiloHertz (kHz), MegaHertz (MHz)
Resolution 1 kHz
Range 10 kHz to 2470 MHz, continuously variable or 1-2-5 steps

Resolution Bandwidth
(RBW)

Width of the resolution bandwidth filter

Units Hertz (Hz), kiloHertz (kHz), MegaHertz (MHz)
Resolution Uses 1-3 steps to cover the range
Range 10 Hz to 6 MHz

When in Auto mode, the instrument automatically sets the RBW. The RBW is set as a combination
of 1-3 steps at the 1, 2, 5 span settings, and a linear range between 1, 2, 5 span settings, for
a nominal value of approximately span/125.
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Table 3: Spectral analysis (cont.)

Characteristic Description
Reference Level The power level indicated by the top line of the spectral display

Units dBm
Resolution 1 dBm
Range –100 dBm to +30 dBm

Spectral Display
Amplitude

Units dB relative to Reference Level
Resolution 0.1 dB
Accuracy ± 1.25 dB, –20 dBm to +30 dBm

± 2.0 dB, –80 dBm to –20 dBm
± 2.75 dB, –120 dBm to –80 dBm
± 5 dB –134 dBm < Input < –120 dBm, typical
Accuracy specifications apply only for spans less than 1000 MHz and to CW-like signals.
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Table 3: Spectral analysis (cont.)

Characteristic Description
Vertical Scale Factor

Units 1 dB to 10 dB in 1 dB increments
Display Modes Normal: updates display with each new result

Max Hold: updates displayed point only if new point > old point
Min Hold: updates displayed point only if new point < old point
Max/Min Hold: displays a bar between Max Hold and Min Hold
Average: displays average of N (specified by user) results
Reference information: Average is calculated as follows: The last N values are saved in memory;
when a new result is available, the earliest result of the N stored values is discarded, the new
average is calculated from the stored values. If the number of results is less than N, then all of
the results are averaged together.

Number of Averages 1 ≤ N ≤ 99
Spurious Free
Dynamic Range
(external signal
related)

IM3 better than –70 dBc typical, 100 MHz to 2500 MHz
2nd Harmonic better than –60 dBc, typical
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Table 3: Spectral analysis (cont.)

Characteristic Description
Residual Spurious
Signals

–125 dBm at BTS Rx frequencies (776–794, 806–849, 872–940, 1453–1465, 1525–1549,
1710–1785, 1840–1910,1920–1980) MHz and GPS frequencies (L1 1570.3–1580.5, L2
1222.5–1232.8, L5 1171.4–1181.6) MHz
–115 dBm at BTS Tx frequencies (746–764, 832–834, 840–960, 1477–1513, 1805–1880,
1930–1990, 2110–2170) MHz
–95 dBm at frequencies not listed above, except from 1155–1168 MHz: -20 dBm in spans above
10 MHz, 1155 MHz–1175 MHz

Table 4: Interference analysis characteristics

Characteristic Description
Noise Floor
Measurement

Measures the interference power that is coming into the receiver antenna for any standard.
Measurement defaults to uplink channel when specified by channel number.

Units dBm
Resolution 0.1 dB
Accuracy ± 3 dB typical

AM Demodulation Provides an audio output signal after AM demodulation of the user-selected signal to use for
identifying a signal.

Measurement
Frequency

30 MHz to 2500 MHz with 1 kHz resolution
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Table 4: Interference analysis characteristics (cont.)

Characteristic Description
Input Signal Level –100 dBm minimum
Measurement
Bandwidth

8 kHz

Audio Output
Bandwidth

4 kHz

Run Time 4 seconds per activation
FM Demodulation Provides an audio output signal after FM demodulation of the user-selected signal to use for

identifying a signal.
Measurement
Frequency

30 MHz to 2500 MHz with 1 kHz resolution

Input Signal Level -100 dBm minimum
Maximum Signal
Deviation

Up to 100 kHz

Measurement
Bandwidth

8 kHz, 15 kHz, 75 kHz, 200 kHz; selected by user

Audio Output
Bandwidth

4 kHz for Measurement BW = 8 kHz, 15 kHz
15 kHz for Measurement BW = 75 kHz, 200 kHz

Run Time 4 seconds per activation
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Table 4: Interference analysis characteristics (cont.)

Characteristic Description
Signal Strength Indicator Provides an audio tone and a visual display that vary with the strength of the selected signal.

Measurement
Frequency

30 MHz to 2500 MHz with 1 kHz resolution

Input Signal Level –110 dBm minimum
Measurement
Bandwidth

Up to 10 MHz, dependent on span setting

Tone Type Variable beep rate, based on signal strength
Variable frequency tone, based on signal strength

Table 5: Scanner characteristics

Characteristic Description
W-CDMA Scrambling
Code Analyzer

Detects scrambling codes and pilot channel power levels of received co-channel W-CDMA
downlink signals.

Input Signal Range –117 to +30 dBm, typical
Units and Resolution Io, Ec: dBm

Ec/Io: dB
0.1 dB
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Table 5: Scanner characteristics (cont.)

Characteristic Description
Accuracy Ec:

±2 dB for Ec ≥ –102 dBm and Ec/Io ≥ –12 dB, typical
±3 dB for Ec ≥ –112 dBm and Ec/Io ≥ –14 dB, typical

Display Controls Sort by Power (descending Ec value)
Sort by Scrambling Code (ascending SC index)
Lock (set) current Scrambling Code set

cdma2000 PN Scanner Detects PN Offset, Tau (Timing Error) and Pilot Channel power levels of multiple co-channel
cdmaOne and/or cdma2000 forward link signals.

Input Signal Range –120 to +30 dBm, typical
Units Io, Ec: dBm

Ec/Io: dB
PN Offset: PN index (0 to 511)
Tau: chips

Resolution Ec, Io, Ec/Io: 0.1 dB
PN Offset: 1 PN
Tau: 0.1 chip

82 RF Scout Quick Start User Manual



Specifications

Table 5: Scanner characteristics (cont.)

Characteristic Description
Accuracy Ec:

±2 dB for Ec ≥ –95 dBm and Ec/Io ≥ –8 dB, typical
±3 dB for Ec ≥ –110 dBm and Ec/Io ≥ –12 dB, typical
Tau:
0.5 chip, of highest power multipath component of each detected PNOS, relative to input timing
reference (ESC or YBGPS1), typical.

Display Controls Sort by Power (descending Ec value)
Sort by PN offset (ascending offset values)
Lock (set) current PN Offset values

1xEV-DO PN Scanner Detects PN Offset, Tau (Timing Error) and Pilot Channel power levels of multiple co-channel
1xEV-DO forward link signals. Up to 10 PN offsets are displayed.
Io: The total received power in the pilot intervals of the signal, within the signal bandwidth
(1.23 MHz).
Ec: The absolute power level of the detected pilot at the indicated PN Offset, in dBm.

Input Signal Range –120 to +30 dBm, typical
Units Io, Ec: dBm

Ec/Io: dB
PN Offset: PN index (0 to 511)
Tau: chips
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Table 5: Scanner characteristics (cont.)

Characteristic Description
Resolution Ec, Io, Ec/Io: 0.1 dB

PN Offset: 1 PN
Tau: 0.1 chip

Accuracy, typical Ec:
± 2.5 dB for Ec ≥ –95 dBm and Ec/Io ≥ –8 dB
± 3.5 dB for Ec ≥ –110 dBm and Ec/Io ≥ –12 dB
Tau:
±0.5 chip, of highest power multipath component of each detected PNOS, relative to input timing
reference (ESC or YBGPS1)

Display Controls Sort by Power (descending Ec value)
Sort by PN offset (ascending offset values)
Lock (set) current PN Offset values

GSM Channel Scanner The GSM channel scanner displays channel power and related information on a maximum of 128
GSM forward link signals.
Displays Channel, Frequency, Peak Power, Traffic Type, C/I, and BSIC
The scanner is intended for off-air reception using an antenna, and measures only forward (down)
link signals. This measurement requires that YBT250 option GS1 is installed.

Input Signal Range –120 to +30 dBm, typical
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Table 5: Scanner characteristics (cont.)

Characteristic Description
Units Frequency: MHz

Peak Power: dBm
C/I: dB

Resolution Frequency: 0.001 MHz
Peak Power: 0.1 dBm
C/I: 0.1 dB

Accuracy, typical ± 1 dB, –20 dBm to +30 dBm, ± 0.75 dB for identified GSM channels
The center frequency is derived from the channel number.
C/I is derived from EVM using the following equation:

C/I = –20 * log10(EVM/100)
Display Controls AutoLevel (graph)

Sort table by power or frequency
Start and stop channel select
Peak hold
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Table 5: Scanner characteristics (cont.)

Characteristic Description
TD-SCDMA Scanner Detects Sync code index, and DwPts Channel power levels of multiple co-channel TD-SCDMA

forward link signals. Up to 10 Sync codes are displayed.
Io: The total received power in the DwPts of the signal, within the signal bandwidth (1.6 MHz), in
dBm.
Ec: The absolute power level of the detected DwPts at the indicated Sync Code, in dBm.

Input Signal Range –120 to +30 dBm, typical
Units Io, Ec: dBm

Ec/Io: dB
Sync Code: Sync Code index (0 to 31)

Resolution Ec, Io, Ec/Io: 0.1 dB
Sync Code index: 1 code index offset

Accuracy, typical Ec:
± 2.0 dB for Ec ≥ –85 dBm and Ec/Io ≥ –8 dB
± 3.5 dB for Ec ≥ –105 dBm and Ec/Io ≥ –12 dB

Display Controls Sort by Power (descending Ec value)
Sort by Sync Code (ascending offset values)
Lock (set) current Sync Code values
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Table 6: Signal measurement characteristics

Characteristic Description
RF Channel Power Measures the average RF power in a user-defined channel. The default value of channel bandwidth

is taken from the selected standard. The acceptable values for channel numbers are taken from the
selected standard. The user can input the channel center frequency instead of the channel number.

Units and Resolution Watts (W), dBm
3 significant digits for W; 0.1 dB for dBm units

Accuracy ± 0.75 dB: –20 dBm to +30 dBm, ± 0.5 dB typical
± 1.25 dB: –80 dBm to –20 dBm, ± 1.0 dB typical
Reference information: Accuracy is guaranteed for input signals between –80 and +30 dBm total
power (CW or peak envelope). Accuracy specification is typical down to –120 dBm total power.

RF Power (GSM/EDGE) Measures the average RF power of the useful part of a GSM or EDGE burst (GMSK or 8-PSK
modulation), as determined by the location of the burst Training Sequence.

Units and Resolution dBm: 0.01 dB for dBm units
Accuracy For GSM or EDGE (GMSK or 8-PSK modulation) burst signals, the RF power measurement

accuracy is:
± 1.0 dB: –20 dBm to +30 dBm, ± 0.75 dB typical
± 1.5 dB: –80 dBm to -20 dBm, ± 1.25 dB typical
Reference information: Burst timing is determined from the location of the burst Training Sequence.
If Burst timing cannot be found, the power measurement will be done on an arbitrarily selected
segment of the signal equal to the useful part of a slot.
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
RF Power (1xEV-DO) Measures the RF power in the Pilot, MAC, and Data intervals of a 1xEV-D0 timeslot.

Units and Resolution dBm: 0.01 dB for dBm units
Accuracy For burst signals, the RF power measurement accuracy is:

± 1.0 dB: –20 dBm to +30 dBm, ± 0.75 dB typical
± 1.5 dB: –80 dBm to –20 dBm, ± 1.25 dB typical

RF Power (TD-SCDMA) Measures the average RF power on individual timeslots (excluding the guard period) as determined
by the location of the downlink pilot timeslot (DwPTS).

Units and Resolution dBm: 0.01 dB for dBm units
Accuracy For burst signals, the RF power measurement accuracy is:

± 1.0 dB: –20 dBm to +30 dBm, ± 0.75 dB typical
± 1.5 dB: –80 dBm to –20 dBm, ± 1.25 dB typical
Reference information: Burst timing is determined from the power envelope profile of the DwPTS.
If the DwPTS cannot be found, an error message is displayed.
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
RF Channel Carrier
Frequency

Measures the frequency of the carrier in the user selected channel. The user can enter a channel
number or frequency.

Units and Resolution MegaHertz (MHz): 1 Hz
Accuracy ± (10 Hz + Time Base Error), 99% confidence interval

W-CDMA: ± (12 Hz + Time Base Error), 99% confidence interval
Note: The carrier frequency must be within 10 kHz of the expected value, except:
W-CDMA, 1xEV-DO, and GSM/EDGE: within 5 kHz
IS-136: within 1.5 kHz
W-CDMA 3GPP Test Model 4

Accuracy using
YBGPS1 GPS Timing
Reference

± (10 Hz + 0.015 ppm), typical
Note: The carrier frequency must be within 10 kHz of the expected value, except:
W-CDMA, 1xEV-DO, and GSM/EDGE: within 5 kHz
IS-136: within 1.5 kHz
The GPS antenna and the instrument antenna should be stationary for specified accuracy. Doppler
shift of BST frequency is ± 0.09 ppm when the instrument antenna is moving at 60 mph (100 km/hr).
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
FM Deviation Measures the maximum one-side frequency deviation of the analog FM cellular carrier selected by

the user after demodulation. The user can enter a channel number or frequency.
Units and Resolution kiloHertz (kHz): 0.1 kHz
Accuracy ± 10% for 2 kHz ≤ Deviation ≤ 10 kHz

Maximum measurable deviation is 15 kHz peak.
Maximum modulation frequency is 3 kHz.

PN Offset Measures the PN Offset of the cdmaOne or cdma2000-1x signal. The user can select the CDMA
signal of interest by a channel number or frequency.

Units and Resolution PN Index: 1 PN Index, where each PN Index is 64 chips
Accuracy Displayed PN Index must match the PN Offset of the CDMA signal.

Pilot Time Alignment
Error (Tau)

Measures the time offset between the PN sequence of the input signal and the External Even
Second Clock (on Timing Input connector).

Units and Resolution Microsecond (μs), Chips: 0.1 μs (1 chip)
Accuracy ± 250 ns typical
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
Waveform Quality
(Rho, ρ)

Measures the waveform quality as defined by IS-97-D using a pilot-only CDMA (or cdma2000-1x)
signal.

Units and Resolution None: 0.0001
Accuracy ± 0.005, 0.9 ≤ ρ ≤ 1.0; Usable range 0.5 ≤ ρ ≤ 1.0

Degradation due to adjacent channel CDMA carriers (having equivalent power): add ±0.015.
Reference information: The Rho measurement is only specified for a pilot-only CDMA signal. The
accuracy specification given here applies only to measurements made on a pilot-only CDMA signal,
with the instrument set to use the pilot-only method. For measurements on signals that are not
pilot-only, see the Estimated Waveform Quality measurement.

Waveform Quality (Rho
Pilot, Rho MAC, Rho
Data) (1xEV-DO)

Rho (ρ) for 1xEV-DO signals provides an indication of the signal to distortion ratio for the transmitted
signal. This quality measure is an indication of how similar the transmitted signal is to a perfect
signal. Rho can vary between 0.0 and 1.0, where 1.0 represents a perfect signal.
Rho Pilot is only computed on chips in the Pilot intervals. Pilot Rho is measured on the pilot interval
of 20 half slots.
Rho MAC is only computed on chips in the MAC interval. Rho MAC is measured on the MAC
interval of 20 half slots.
Rho Data is only computed on chips in the Data interval. Rho Data is measured on the Data interval
of 20 half slots.

Units and Resolution None: 0.0001
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
Accuracy ± 0.005, 0.9 ≤ ρ ≤ 1.0; Usable range 0.5 ≤ ρ ≤ 1.0

Degradation due to adjacent channel CDMA carriers (having equivalent power): add ±0.015.
Estimated Waveform
Quality

Measures waveform quality as defined by IS-97-D using any CDMA signal.

Units and Resolution None: 0.0001
Accuracy ± 0.01 for rho ≥ 0.9, typical

Reference information: The Rho measurement as given in IS-97-D is only specified for a pilot-only
CDMA signal. This measurement makes an estimate of the Rho value on any CDMA signal.

Error Vector Magnitude
(EVM) (cdmaOne and
cdma2000)

The normalized RMS of all of the vectors that extend from the intended constellation points to the
actual symbol points in a record of symbols.

Units and Resolution Percent: 0.01%
Accuracy ±1%; EVM ≤ 31%

Degradation due to adjacent channel CDMA carriers (having equivalent power): add 10%
Residual error: 5% < 1000 MHz; 7% < 2000 MHz
Reference information: These measurements are accurate for both pilot-only and in-service CDMA
signals.
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
Error Vector Magnitude
(EVM) (W-CDMA)

The normalized RMS of all of the vectors that extend from the intended constellation points to the
actual symbol points in a record of symbols.

Units and Resolution Percent: 0.01%
Accuracy (W-CDMA
composite)

±2.5%; 12.5% ≤ EVM ≤ 22.5%
Residual error: 6% < 1000 MHz; 8% < 2500 MHz
Reference information: The W-CDMA composite refers to a signal with one or more channels using
QPSK modulation, or a combination of QPSK and 16QAM modulation. The EVM measurement
readout displays the EVM for the composite signal. W-CDMA 3GPP Test Model 4.

(W-CDMA
EVM16QAM)

±1.5%; 6.5% ≤ EVM16QAM ≤ 22.5%, typical
Residual error: 4%
Reference information: The EVM16QAM measurement readout displays the symbol EVM for the
code channels using 16QAM modulation.

Synchronization
Channel Power
(W-CDMA)

Measures the Primary Synchronization Channel (P-SCH) and Secondary Synchronization Channel
(S-SCH) power.

Units and Resolution dBm, W: 0.1 dBm
Carrier Feedthrough Measures the offset of the constellation from zero power.

Units and Resolution dB relative to full carrier power: 0.1 dB

RF Scout Quick Start User Manual 93



Specifications

Table 6: Signal measurement characteristics (cont.)

Characteristic Description
Accuracy cdmaOne and cdma2000: ± 2 dB

Residual floor: –50 dBc
Reference information: For cdmaOne and cdma2000, the carrier feedthrough measurement is valid
only for a pilot-only signal.

Pilot Power Measures the absolute power of the pilot, without regard to whether other codes are present.
(P-CPICH for W-CDMA.)

Units and Resolution dBm, Watts (W): 0.1 dB
Accuracy ± 1 dB, –20 dBm to +30 dBm

± 1.5 dB, –50 dBm to –20 dBm
Reference information: W-CDMA 3GPP Test Model 2.

Sync Power Measures the absolute power of the W-CDMA sync channel (SCH), without regard to whether
other codes are present.

Units and Resolution dBm, Watts (W): 0.1 dB
Occupied Bandwidth The Occupied Bandwidth measurement displays the frequency bandwidth within which 99% of the

power transmitted on a single channel lies. This measurement can be properly made only if the
channel being measured has no channels adjacent to it.

Units and Resolution Hertz (Hz): Three significant digits
Accuracy 5% of the reading, typical

Reference information: For TD-SCDMA signals, OBW is measured for each timeslot.
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
Adjacent Channel
Leakage power Ratio
(ACLR) (W-CDMA)

Measures the ratios of the mean RRC filtered power in the 5 MHz BW assigned channel to the
mean RRC filtered power in each of the nearest 5 MHz BW 1st and 2nd adjacent upper and lower
channels. Adjacent channel centers are offset in multiples of 5 MHz from the assigned channel
center. The user can enter the channel center frequency instead of the channel number.

Units and Resolution dB: 0.01 dB
Accuracy ± 1.5 dB, 20 ≤ ACLR < 48 dB, typical

± 2.5 dB, 48 ≤ ACLR < 53 dB, typical
–30 dBm to +20 dBm (power in assigned channel)
Reference information: WCDMA Test Model 1 signal (3G PP TS25.141). The filter response is
Root-Raised Cosine (RRC), alpha = 0.22, and 3.84 MHz noise BW (3GPP TS25.104).

Error Vector Magnitude
(EVM) (GSM/EDGE)

Error Vector Magnitude is the normalized RMS value of all of the vectors that extend from the
intended constellation points to the actual symbol points in a record of symbols. The EVM
measurement is made over one GSM or EDGE burst.

Units and Resolution Percent: 0.01%
Accuracy ± 1.5%, 4% ≤ EVM < 10%. Residual error: 4.0%

Phase Error
(GSM/EDGE)

Phase Error is the RMS value of the differences between the phase angles of the received signal
and those of an ideal reconstructed signal. The Phase Error measurement is made over one
GSM or EDGE burst.

Units and Resolution Degrees: 0.01°
Accuracy ± 1.0, 2 ≤ Phase Error < 12. Residual error: 2.0
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
Origin Offset
(GSM/EDGE)

Origin Offset is the ratio of unmodulated signal power to modulated signal power. The unmodulated
signal component causes the signal constellation center to be offset from the ideal location. The
Origin Offset measurement is made over one GSM or EDGE burst.

Units and Resolution dB: 0.01 dB
Range –15 dB to -60 dB

Carrier to Interference
(C/I) (GSM/EDGE)

Carrier to Interference (C/I) is the ratio of desired signal (carrier) to undesired signal (interference).
The C/I measurement is derived from the EVM result and gives an estimate of the power-based C/I
value. The C/I measurement is made over one GSM or EDGE burst.

Units and Resolution dB: 0.01 dB
Range 0 dB to 50 dB

Reference information: C/I is derived from EVM using the following equation:
C/I = -20 * log10( EVM/100 )
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Table 6: Signal measurement characteristics (cont.)

Characteristic Description
RF Power vs Time
(GSM/EDGE)

RF Power vs Time displays the normalized signal envelope power over one GSM or EDGE burst.

Units and Resolution Symbols: 1 symbol.
Microseconds: 1 microsecond.

Time Uncertainty ±0.2 symbol
±0.8 microsecond
Reference information: Burst to mask alignment is derived from the location of the Training
Sequence in the useful part of the burst.

Table 7: Environmental characteristics

Characteristic Description
Temperature Range Operating: 0 °C to +50 °C specified performance, –10 °C to +50 °C typical

Nonoperating: –40 °C to +60 °C
Humidity Operating: 5% to 95% Relative Humidity (RH), noncondensing: up to +30 °C

Nonoperating: 5% to 45% Relative Humidity (RH), noncondensing: +30 °C up to +50 °C
Altitude Operating: Up to 4,600 m (15,092 ft.)

Nonoperating: Up to 15,240 m (50,000 ft.)
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Table 8: Physical characteristics

Characteristic Description
Dimensions Height: 25 cm. (9.75 in)

Width: 33 cm. (13 in)
Depth: 9 cm. (3.5 in)

Weight 5.5 kg (12.125 lbs): Y400, YBT250, and 1 battery

Table 9: Miscellaneous characteristics

Characteristic Description
Battery Life One battery installed: 2 hours with measurements active, 4 hours in suspend mode

Two batteries installed: 4 hours with measurements active, 8 hours in suspend mode
Recommended Instrument
Calibration Interval

2 years
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Table 10: Safety compliance

Category Description
Safety Compliance ANSI/UL61010-1:2004

Electrical Equipment for Measurement, Control, and Laboratory Use.
CSA C22.2 No. 61010.1:2004

Electrical Equipment for Measurement, Control, and Laboratory Use.
EN 61010-1:2001

Electrical Equipment for Measurement, Control, and Laboratory Use.
IEC61010-1:2001

Electrical Equipment for Measurement, Control, and Laboratory Use.
ISA 82.02.01

Electrical Equipment for Measurement, Control, and Laboratory Use.
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Certifications and Compliances
EC Declaration of Conformity – EMC
Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

EN 61326:1997. EMC requirements for Class A electrical equipment for measurement, control, and laboratory use. 1, 2, 3, 4

IEC 61000-4-2:1999. Electrostatic discharge immunity (Performance criterion C)

IEC 61000-4-3:2002. RF electromagnetic field immunity (Performance criterion A) 5

IEC 61000-4-4:2004. Electrical fast transient / burst immunity (Performance criterion B)

IEC 61000-4-5:2005. Power line surge immunity (Performance criterion B)

IEC 61000-4-6:2003. Conducted RF immunity (Performance criterion A) 5

IEC 61000-4-11:2004. Voltage dips and interruptions immunity (Performance criterion B)

EN 61000-3-2:2000. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European Contact.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom
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1 This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
2 Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
3 To ensure compliance with the EMC standards listed here, high quality shielded interface cables should be used.
4 Minimum Immunity test requirement.
5 Performance Criteria: Residual spurious signals can increase to –70 dBm with exposure to the disturbance levels of this test.

Australia / New Zealand Declaration of Conformity – EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

EN 61326:1997. EMC requirements for electrical equipment for measurement, control, and laboratory use.
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Index
Symbols and Numbers
?, 25

A
AC adapter, 2
AC adapter, connecting, 4
Accessories, standard, 1
Active GPS receiver and maps, 54
Active GPS, definition, 54
Adapter, AC, connecting, 4
Add a marker to a waveform, 38
Add signal standards to select list, 12
Altitude specifications, 2
Amplifier, RF input signal, 22
ArcInfo Shape (.shp) map file, 67
Attenuator, RF input signal, 22
Audio tab, 47
Automatic iMap measurements, 63

B
Battery

charge status, 16
charge times, 5

charging, 5
Bitmap file (iMap), 54, 67
BMP (iMap), 54
Button

Channel measurement mode, 23
channel select, 21
downlink, 21, 26
Edit, 20
F EXT, 22
F GPS, 22
F INT, 22
forward link, 21
frequency select, 21
GPS status, 22
help, 25
Help, 20
iMap log measurements, 63
iMap mapping mode, 23
log measurements (not iMap), 20
log measurements, iMap, 63
measurement mode, 23
measurement reference

frequency status, 22
Open, 20

Pause, 20
PN Sync status, 22
power on/standby, 16
reset, 16
reverse link, 21
RF input signal gain/loss, 22
Run, 20
save results, 20
signal measurement mode, 23
spectrum measurement

mode, 23
traces, 39
uplink, 21, 26

C
Calibrate the touch screen, 8
Change the spectrum graph reference

level, 33
Change the spectrum graph vertical

scale, 33
Changing

application sceen colors for
printing, 11

numbers in fields, 24
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Channel measurement mode
button, 23

Channel select button, 21
Charging the batteries, 5
Cleaning the instrument, 3
Clock, Even Second, 18
Color, iMap measurement icons, 59
Command bar, 19, 20
Comparing live and saved

waveforms, 40
Comparing two live waveforms, 40
Comparing two saved waveforms

(spectrum), 42
Concepts, touch screen, 7
Connecting the AC adapter, 4
Connectors

input & output (Y400), 17
Reference Frequency Input, 18
RF Input, 18
Timing Input, 18
YBT250 module, 18

Conventions used in this manual, x
Converting maps to GSF, 67

D
Definition

active GPS receiver, 54
grid map, 54
image map, 54

Deletemap measurement icons,
iMap, 60

Dimensions, 2
Direction arrow, iMap, 61
Display a Spectrogram, 44
Display a spectrum waveform, 31
Displaying

power on/off status, 16
Displaying markers, 34
Documentation, ix
Downlink button, 21, 26
Drag, 7
Drawing a map measurement direction

arrow, 61

E
Edit button, 20
Enabling signal standards, 12
Entering numbers in fields, 24
ESC, 18
Ethernet connector (RJ-45), 17
Even Second Clock, 18
External Reference status button, 19

External RF input signal amplifier, 22
External RF input signal attenuator, 22
External timing reference signal

input, 18

F
Forward link button, 21
Frequency reference input

specification, YBT250, 72
Frequency select button, 21
Front Trace (marker), 35
Functional verification, 6

G
Getting help on measurements, 25
GIF file (iMap), 54, 67
GPS status button, 19, 22
GPS, active, definition, 54
Grid map, 54
GSF, 54
GSF, converting maps to, 67

H
Headphone jack, 17
Help
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accessing online help, 25
button, 20
link text, 25

Humidity operation specifications, 2

I
Image map, 54
iMap

automatic map measure-
ments, 63

Bitmap file, 54, 67
converting maps to GSF, 67
delete measurement icons, 60
direction arrow, drawing, 61
draw a direction arrow, 61
GIF file, 54, 67
Google Earth, Microsoft

MapPoint, 67
grid map file, 54
icon color, 59
icon types, 59
image map file, 54
JPEG file, 54, 67
loading a map file, 55
log measurements button, 63
logging measurements, 63

map file concepts, 54
mapping a measurement, 56
mapping mode button, 23
measurement icon color, 59
measurement icon types, 59
measurement icons, delete, 60
measurement icons, viewing, 60
measurement mapping, 56
move a measurement icon, 56
PNG file, 54, 67
TIFF file, 54, 67
tool overview, 53
viewing mapped measurement

icons, 60
iMap Converter, 67
Improve measurement accuracy, 18
Indoor color scheme, 11
Input field entry controls, 24
Input signal characteristics, 2
Input/Output connectors, 17
Installation, 1
Instrument cleaning, 3
Instrument elements, 15
Interference measurements

Audio, 47
Noise, 48
Strength, 46

Interfering signal audio
demodulation, 47

J
JPEG file (iMap), 54, 67

K
Key features, viii
Keypad button, 24
Knob control, 24

L
Lightning, preventing personal

injury, xi
Listening to an interfering signal, 47
Live and saved waveforms,

comparing, 40
Loading a map file, 55
Locating an interfering signal, 46
Log measurements button (not

iMap), 20
Log measurements button, iMap, 63
Logging iMap measurements, 63
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M
Map file concepts, 54
Map file conversion program

(iMap), 67
MapInfo Interchange Format (.mif)

map file, 67
Mapping a measurement, 56
Markers

absolute marker readouts, 37
add a marker to a waveform, 38
delta marker readouts, 37
displaying, 34
Front Trace, 35
marker readout scroll buttons, 36
measurement mode, 37
overview, 34
selecting which markers to

display, 35
setup, 35
Trace 1, 35
Trace 2, 35
turning on or off, 34
View > Marker Setup, 35

Measurement
mode buttons, 19, 23
reference frequency status

button, 22

results screen, 19
Measurement icon colors, iMap, 59
Measurement icon direction arrow,

iMap, 61
Measurement icon types, iMap, 59
Measurement icons, iMap,

deleting, 60
Measurement icons, iMap, viewing, 60
Measurement mapping, iMap, 56
Measuring noise floor

(interference), 48
Menus, 20
Microphone input, 17
Microsoft WindowsCE user

interface, 18
.mif, 54
MIF, 54
Move a measurement icon, iMap, 56

N
Noise floor measurement, 48
Noise tab, 48

O
Online help, 25
Open button, 20

Opening RF Scout, 10
Operating considerations, 2
Outdoor color scheme, 11
Overview, iMap, 53

P
Parameter entry controls, 19, 24
Parts of the instrument, 15
Pause button, 20
PN Sync status button, 22
PNG file (iMap), 54, 67
Power adapter, 2
Power On/Standby button, 16
Power/Display status, 16
Powering on and off the instrument, 6
Preventing personal injury from

lightning, xi
PS/2 keyboard connector, 17

R
Readout scroll buttons, marker, 36
Ref Lvl, 33
Reset button, 16
Reverse link button, 21
RF input

characteristics, 2
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signal connector, 18
signal gain/loss button, 22
YBT250, 71

RF Signal Gain/Loss status button, 19
Run button, 20
Running RF Scout, 10

S
Safety Summary, iii
Save results button, 20
Saved waveforms, comparing

(spectrum), 42
Screen display colors, 11
Select which markers to display, 35
Selecting signal standard to

measure, 21
Selecting waveforms (traces), 39
Serial RS-232 connector, 17
Set which markers to display, 35
Setting

display colors, 11
signal standards, 12
the channel number, 21
the measurement frequency, 21
to take a measurement, 26

Setup dialog box, 31

Signal audio demodulation, 47
Signal input characteristics, 2
Signal input connectors

Reference Frequency Input, 18
RF Input, 18
Timing Input, 18

Signal locating (interference), 46
Signal measurement mode button, 23
Signal standard selection list, 21
Software upgrades, x
Specifications, 71
Spectrogram, displaying, 44
Spectrum

absolute marker readouts, 37
add a marker to a waveform, 38
change graph reference level, 33
change graph vertical scale, 33
comparing live and saved

waveforms, 40
comparing two live

waveforms, 40
comparing two saved

waveforms, 42
delta marker readouts, 37
display a spectrogram, 44
displaying markers, 34
Front Trace marker mode, 35

marker readout scroll buttons, 36
markers overview, 34
measurement mode, 37
saved waveforms, comparing, 42
selecting waveforms (traces), 39
selecting which markers to

display, 35
setup markers, 35
take a measurement, 31
Trace 1 marker mode, 35
Trace 2 marker mode, 35
traces button, 39
turning on or off markers, 34
View > Marker Setup, 35
waveforms (traces), selecting, 39

Spectrum measurement mode
button, 23

Standard accessories, 1
Starting RF Scout, 10
Status panel, 16
Strength tab, 46
Stylus, 7

T
Tab

Audio (Interference mode), 47
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Noise (Interference mode), 48
Strength (Interference mode), 46

Taking a channel measurement, 49,
69

Taking a spectrum measurement, 31
Tap, 7
Temperature range operation

specifications, 2
TIFF file (iMap), 54, 67
Timing input specification, YBT250, 73
Touch screen

calibrate, 8
concepts, 7
on/off status, 16

Trace 1 (marker), 35
Trace 2 (marker), 35
Traces button, 39
Tuning controls, 19, 21
Turning on or off markers, 34

U
Underlined blue text, 25
Unpack the instrument, 1
Updates button (spectrogram), 44
Upgrades, software, x
Uplink button, 21, 26

USB Host connector, 17
USB Slave connector, 17
User interface

command bar, 19, 20
External Reference status

button, 19
GPS status button, 19
Measurement mode buttons, 19
measurement results screen, 19
menus, 20
overview, 19
Parameter entry controls, 19
RF Signal Gain/Loss status

button, 19
tuning controls, 19

USGS Digital Line Graph (.opt) map
file, 67

V
Verifying instrument functionality, 6
Vertical Scale, 33
Viewing measurement icons, iMap, 60

W
Waveforms

add a measurement marker, 38
change graph reference level, 33
change graph vertical scale, 33
comparing, 39
comparing live and saved

waveforms, 40
comparing two live

waveforms, 40
comparing two saved

waveforms, 42
Waveforms (traces), selecting, 39
Weight, 2

Y
Y400 user interface elements, 18
YBT250 module connectors

FREQUENCY REFERENCE
input specification, 72

Reference Frequency Input, 18
RF Input, 18
RF input specification, 71
Timing Input, 18
TIMING input specification, 73
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